In 1929 Gustav Tauschek obtained a patent on OCR in Germany, followed by Paul W. Handel
who obtained a US patent on OCR in USA in 1933 (U.S. Patent 1,915,993). In 1935 Tauschek
was also granted a US patent on his method (U.S. Patent 2,026,329). Tauschek's machine was a
mechanical device that used templates and a photodetector.

In 1949 RCA engineers worked on the first primitive computer-type OCR to help blind people
for the US Veterans Administration, but instead of converting the printed characters to machine
language, their device converted it to machine language and then spoke the letters. It proved far
too expensive and was not pursued after testing.[”

In 1950, David H. Shepard, a cryptanalyst at the Armed Forces Security Agency in the United
States, addressed the problem of converting printed messages into machine language for
computer processing and built a machine to do this, reported in the Washington Daily News on
27 April 1951 and in the New York Times on 26 December 1953 after his U.S. Patent 2,663,758
was issued. Shepard then founded Intelligent Machines Research Corporation (IMR), which
went on to deliver the world's first several OCR systems used in commercial operation.

In 1955, the first commercial system was installed at the Reader's Digest. The second system
was sold to the Standard Oil Company for reading credit card imprints for billing purposes.
Other systems sold by IMR during the late 1950s included a bill stub reader to the Ohio Bell
Telephone Company and a page scanner to the United States Air Force for reading and
transmitting by teletype typewritten messages. IBM and others were later licensed on Shepard's
OCR patents.

In about 1965, Reader's Digest and RCA collaborated to build an OCR Document reader
designed to digitise the serial numbers on Reader's Digest coupons returned from advertisements.
The fonts used on the documents were printed by an RCA Drum printer using the OCR-A font.
The reader was connected directly to an RCA 301 computer (one of the first solid state
computers). This reader was followed by a specialised document reader installed at TWA where
the reader processed Airline Ticket stock. The readers processed documents at a rate of 1,500
documents per minute, and checked each document, rejecting those it was not able to process
correctly. The product became part of the RCA product line as a reader designed to process
"Turn around Documents” such as those utility and insurance bills returned with payments.

The United States Postal Service has been using OCR machines to sort mail since 1965 based on
technology devised primarily by the prolific inventor Jacob Rabinow. The first use of OCR in
Europe was by the British General Post Office (GPO). In 1965 it began planning an entire
banking system, the National Giro, using OCR technology, a process that revolutionized bill
payment systems in the UK. Canada Post has been using OCR systems since 1971 cfation needed]
OCR systems read the name and address of the addressee at the first mechanised sorting center,
and print a routing bar code on the envelope based on the postal code. To avoid confusion with
the human-readable address field which can be located anywhere on the letter, special ink
(orange in visible light) is used that is clearly visible under ultraviolet light. Envelopes may then
be processed with equipment based on simple barcode readers.

In 1974 Ray Kurzweil started the company Kurzweil Computer Products, Inc. and led
development of the first omni-font optical character recognition system — a computer program
capable of recognizing text printed in any normal font. He decided that the best application of
this technology would be to create a reading machine for the blind, which would allow blind
people to have a computer read text to them out loud. This device required the invention of two
enabling technologies — the CCD flatbed scanner and the text-to-speech synthesizer. On
January 13, 1976 the successful finished product was unveiled during a widely-reported news



Green County Animal Shelter

ADOPTION/MEDICAL CONTRACT
(Non-Transferable)

Contract No. ABC-157890 Green County Animal Shelter
1234 Green Drive

License No. DXY-23-FP Qweencity, QC 123456
(123) 456-7890

Receipt No. 1234

Animal ID No. 56780

This contract is made between Yan Yanovich Address Green Drive 145, Qweencity QC 1245678
Phone No. 145-678-908 and Green County Animal Shelter on, (date) 12/03/07 . The fee for adoption is $25.00 which
is refundable only when said terms of this contract are met and conditions specified apply.

2

A

The Wilson County Animal Shelter agrees to the following:

To give the adopter a receipt when he/she assumes possession and control of the animal described herein:

Breed cat Color brown Sex male

To exchange or make refund on any animal that requires major medical treatment as certified by a veterinarian or

dies from natural causes within 7 calendar days from the date of adoption; either must be requested by adopter only.

To exchange or make refund on any animal that exhibits unusual or unpredictable behavioral tendencies within 7

calendar days from the date of adoption; either must requested by the adopter only.

The terms of this contract expires at 5:00 p.m. on (date) 12/03/07 F

Participating veterinary hospitals agree to provide the services stated herein for animals adopted from the Wilson County
Animal Shelter at no charge to the adopter and these services must be performed to validate the terms of this contract
except

as pertains to death from natural causes. A free examination will be given o include a visual and physical examination
including a check of temperature, pulse, respiration, eyes, gum coloring, ears, and palpating the abdomen. The
examination

DOES NOT include any lab fees, vaccinations, or medications. These services included will be provided on a one time
basis

only.

In return, as adopter, | Yan Yanovich , agree to the following:
To take the animal to a participating veterinary hospital within stated period of time, which is 7 calendar days, to
receive initial free examination. Form A must be completed by attending licensed veterinarian.

The animal will not be allowed to breed indiscriminately. As the adopter, | agree to provide adequate food, water,
shelter, and exercise and agree to obey all applicable laws governing control and custody of the animal, to include,
but not limited to, the proper confinement laws and wearing of tags as applicable.

To provide with proper veterinary care as related to the specific typé of animal. This is meant to include any yearly or
other vaccinations, any needed medications or other special care as needed.

To exchange an animal, | understand that | must follow these specific criteria:

1. | must have complied with Article A of this section.

Z The animal must be in such poor health that major medical treatment is necessary, unless #3 in this
section
applies. Minor parasitical treatment is not considered a major medical problem.

3. If the above free examination has been performed and the animal's behavior is unacceptable (this is not
to

cover housetraining or any other frainable characteristic) to your household or living conditions, a refund
may be made with the proper completion of Form B.

4, The animal along with the veterinarians completion of Form A shall be brought to the Animal Shelter, or
in
the event of the animal's death, the carcass and/or other satisfactory evidence of the death and date of
death must be presented. Terms of this contract will recognize death by natural causes only.

5. "The request for a refund or exchange must be made by the date and time specified in Section |, Article D
of
this contract.

6. No refund or substitution shall be given for the animal that has been lost, stolen, or Killed.

| understand the adoption contract requirements and further agree that failure to comply with this contract will result in the animal



D. Brawn nufacture

Invoice no. DVT-AX-345678

Payment date; 03/12/2006

Reference Designation Qty Unitprice  Total CHF Sales
Work

SERVICE D COMPLETE OVERHAUL 1 5500.00 5500.00 220
SERVICE D REFRESHING COMPLETE CASE 1 380.00 380.00 220

AND RHODIUM BATH
Exterior parts:

JO.297.0685.FP FLAT GASKET 1 3.00 3.00 220
JO.197.075.FP FLAT GASKET 1 4.00 4.00 220
JO.199.059.08 FLAT ROUND GASKET 1 6.00 6.00 220
VI1.261.036.BC W.G.FIXATION SCREWS 10 4.00 40.00 220
Al.465.055.BC WHITE GOLD "FOIL" 1 70.00 70.00 220
PAIR OF HAND
LENGTH: 10/13.50MM
CALIBRE 2868
SPECIAL DISCOUNT -3003.00 -3003.00
Discount -900.00 -900.00
Total CHF 2100.00
RETURN AFTER REPAIR
NO COMMERCIAL VALUE
Payment;
Mr, John Doe
Green Street 15, Office 4
1234 Vermut

New Caledonia

Credit Card; Visa
Card No: 112345678



18 October 2006

Greg White, Secretary :
321 Green Ave. GX, Room 123
Foxcity, FX 12345

Dear Mr. White:

This is a request for an investigation of companies that conduct so-called "free marketing,”
which is a technique by which corporations seek to influence buying decisions, often by stealth.
There is evidence that some of these companies are perpetrating large-scale deception upon
consumers by deploying free marketers who fail to disclose that they have been enlisted to
promote products

This failure to disclose is fundamentally fraudulent and misleading; and it might violate
prohibitions against unfair or deceptive acts and practices affecting commerce. An investigation
by the Commission could lead to actions against individual free marketers,

and/or to new guidelines requiring disclosure by any and all persons who are paid to engage in
free marketing operations.

Fraud is fraud, and a harmless-sounding name such as "free marketing" doesn't change that.

Sincerely,

Fred Vert,
Executive Director



THE POETIC
SOCIETY

John Grey
Chief Editor
“New World, New Light”

Green Road 15, Office 23
Greencity
New Zeland

FT24 8UC

4 September 2006

Dear John,

In 2000, with an invitation from Tree Press Editor Brian Dom, The Poetic Society agreed to
sponsor the New Light Prize in Poetry for a First Book. As chairman of the Poetic Society, I
consented with pleasure to serve as final judge for the contest — an annual award to recognize and
publish a poet’s first collection. The plans for the press were ambitious: The Book Review would
sponsor a book prize to be givén to any poet, previously published or not; Blue Sky would sponsor

a criticism prize; and Tree Press would publish other books of drama, fiction, and poetry.

I am proud of the books selected for the New Light Prize—books by Greg Best, Lilly Black, Rose
Red, and most recently Fred White. The books have been handsome, widely reviewed, and well

received.

Or three of them have been. Lilly Black was awarded the 2004 prize, but her book has yet to
appear. [ wrote an introduction to Joyful Day — her brilliant, darkly adventurous book of lyrics —



Differences between FineReader versions

: supplied with for beginners for home for office
your scanner
Sprint 4.0 StartUp 5.0 Pro 5.0 Office 5.0
Recognition

Recognition Recognition Recognition

Recognition quality quality better by | quality better by | quality better by
1,5-2 times 1,5-2 times 1,5-2 times
Recognition of superscript, subscript N N
and dropped capitals
Barcode recognition +
Language support
Recognition languages 53 languages 12 languages’ | 176 languages | 176 languages
Muttilingual document recognition + +
Built-in spelling check 30 languages 30 languages
Pattern training for new symbols + +
Creation of new languages +
Saving
Saving in MS Word, MS Excel, + + + +
Word Pro, WordPerfect, StarWriter
Saving in HTML, PDF, RTF, DOC, All save PDF,
XLS, DBF, CSV. and TXT formas | OP R TXT | ™y * !
Export via ODMA +
Interface
OCR Wizard + + +
Built-in editor + +
Network
Network installation +
Distributed document processing over +
a network
Control of licences run simultaneously +
Professional features

Background recognition + +
Batch work + +
Multiprocessing support +
FormFiller +
Correspondence between version of 4.0 Sprint StartUp Standard Professional

series and 5.0 series

I'. English, Dutch (Standard, Belgium), Spanish, Italian, German (Standard, New Spelling), Portuguese
(Standard, Brazilian), Russian, Turkish, French.




Demographic data and estimates Area, Density, Capital City

Projected Percent of Life
Population Population Population of Expectancy Pop. per
Mid-2002 (millions) L atBirth areq of Countries Square
(millions) 2025 <15 65+ (years) (square miles) Mile Capital City
WORLD 6,215 7,859 30 7 67 51,789,601 120
MORE DEVELOPED 1,197 1.249 18 15 76 19,814,584 60
LESS DEVELOPED 5.018 6,61 33 5 65 31,975,017 157
- — Egypt 71.2 96.1 36 4 66 386,66 184 Cairo
PR B | Nigeria 1299 2045 44 3 52 356,668 364 Abuja
O == Ethiopia 67.7 117.6 44 3 52 426,371 159 Addis Ababa
E = Tanzania 37.2 59.8 45 3 52 364,9 102 Dodoma
Congo, Dem. Rep. of hh:2 106.0 48 3 49 905,351 61 Kinshasa
= South Africa 43.6 351 34 [ 51 471,444 93 Pretoria
(3| Canada 31.3 36.0 19 13 79 3,849,670 8 Ottawa
g == | United States 287.4 346.0 21 13 77 3,717,796 77 Washington, DC
4 | § | Mexico 101.7 131.7 33 5 75 756,062 135 Mexico City
qu w= | Argentina 36.5 472 28 10 74 1,073,514 34 Buenos Aires
< Brazil 173.8 219.0 30 6 69 3,300,154 53 Brasilia
— Colombia 43.8 59.7 33 5 71 439,734 100 Bogota
Australia & Oceania 32 40 25 10 75 3,306,741 10
e Bangladesh 133.6 177.8 40 3 59 55,598 2,403 Dhaka
—— India 10495 1,363.0 36 4 63 1,269,340 827 New Delhi
Pakistan 143.5 2421 42 4 63 307,375 467 Islamabad
p— Indonesia 217.0 281.9 81 5 68 735,355 295 Jakarta
M | Pphilippines 80.0 115.5 37 4 68 115,83 691 Manila
Bl | vietnam 79.7 104.1 31 6 68 128,066 622 Hanoi
Bl | china 12807 14547 23 7 71 3,696,100 347  Beijing
® Japan 127.4 121.1 14 18 81 145,869 873 Tokyo
& | United Kingdom 60.2 64.8 19 16 78 94,548 637 London
B[ France 59.5 642 19 16 79 212,934 279 Paris
™ | Germany 824 781 16 16 78 137,83 598  Berlin
a o Russia 143.5 129.1 18 13 65 6,592,819 22 Moscow
[ N | Italy 58.1 575 14 19 80 116,32 499 Rome




Hot Keys

To: Press:

The File menu

Open image from file CTRL+CO
Scan image CTRL+K
Scan multiple images ' CTRL+SHIFT+K
Stop scanning CTRL+T
Create new batch CTRL+N
Open a batch CTRL+P
Save text to file F2
Save image to file F12
The Edit menu
Undo the last action CTRL+Z
Redo the last undone action CTRL+Y
Cut the selection and put it to the cfipboard CTRL+X
Copy the selection to the clipboard CTRLHNS or CTRL+C
Paste the clipboard contents CTRL+V or SHIFT+INS
Delete the active block, the selection, the selected pages DEL
Find the specified text CTRL+F
Find the next occurrence of the search text F3
Seach for and replace the specified text CTRL+H
The View menu
Magnify the image in the Image window CTRL+SHIFT+NUM+
Zoom Out the image in the image window CTRL+SHIFT+NUM-
Zoom In to selected blocks CTRL+SHIFT+NUM*
Properties ALT+ENTER
The Batch menu
Open next batch page ALT+Down
Open previous batch page ALT+Up
Open page with specified number CTRL+G
Close the current page CTRL+4

Delete the recognized text in the Text window CTRL+SHIFT+Del




Capture Front-ends Linked to Backend
Exisiting applications can be improved or
extended using OCR for easy capture of input
of data 1o a networked backend system or
Web applicaition. For example:

- Mobile capture for CRM - take a picture of
a business card for input into a CRM
system or sales lead database

- Mobile capture for Workflow - take a
picture of a document for fast input into a
workflow application

- Client/server text conversion and
processing - collecting pieces of texts and
other data via mobile phone camera and
sending to a Web or other server for
processing. Mobile OCR can be used for
pre-recognition and to check image
quality, before sending to a server for

~_processing.



English

In 1929 Gustav Tauschek obtained a patent on OCR in Germany, followed by Handel
who obtained a US patent on OCR in USA in 1933 (U.S. Patent 1,915,993). In 1935
Tauschek was also granted a US patent on his method (U.S. Patent 2,026,329).
Tauschek's machine was a mechanical device that used templates and a photodetector.

In 1950, David H. Shepard, a cryptanalyst at the Armed Forces Security Agency in the
United States, addressed the problem of converting printed messages into machine
language for computer processing and built a machine to do this, reported in the
Washington Daily News on 27 April 1951 and in the New York Times on 26 December
1953 after his U.S. Patent 2,663.758 was issued. Shepard then founded Intelligent
Machines Research Corporation (IMR), which went on to deliver the world's first several
OCR systems used in commercial operation.

The first commercial system was installed at the Reader's Digest in 1955. The second
system was sold to the Standard Oil Company for reading credit card imprints for billing
purposes. Other systems sold by IMR during the late 1950s included a bill stub reader
to the Ohio Bell Telephone Company and a page scanner to the United States Air Force
for reading and transmitting by teletype typewritten messages. IBM and others were
later licensed on Shepard's OCR patents.

Header

In about 1965 Reader's Digest and RCA collaborated to build an OCR Document reader
designed to digitise the serial numbers on Reader's Digest coupons returned from
advertisements. The font used on the documents were printed by an RCA Drum printer
using the OCR-A font. The reader was connected directly to an RCA 301 computer (one
of the first solid state computers). This reader was followed by a specialised document
reader installed at TWA where the reader processed Airline Ticket stock. The readers
processed document at a rate of 1,500 documents per minute, and checked each
document, rejecting those it was not able to process correctly. The product became part
of the RCA product line as a reader designed to process "Turn around Documents"”
such as those Utility and insurance bills returned with payments.

Header

The United States Postal Service has been using OCR machines to sort mail since
1965 based on technology devised primarily by the prolific inventor Jacob Rabinow. The
first use of OCR in Europe was by the British General Post Office (GPO). In 1965 it
began planning an entire banking system, the National Giro, using OCR technology, a
process that revolutionized bill payment systems in the UK. Canada Post has been
using OCR systems since 1971[citation needed]. OCR systems read the name and
address of the addressee at the first mechanised sorting center, and print a routing bar
code on the envelope based on the postal code. To avoid confusion with the human-

readable address field which can be located anywhere on the letter, specia
in visible light) is used that is clearly visible under ultraviolet light. En
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ABBYY

Extend functionality of mobile devices

with ABBYY technology!

ABBYY, a leading provider of text recognition, data capture
and linguistic software, has implemented its technologies
into a new generation of applications and tools

for mobile devices:

ABBYY mobile text recognition and translation
applications

e ABBYY FotoTranslate provides th 1Siest d fastest way to
transiaie woras o ' : ' )" 1 [ | '
* ABBYY Lingvo Mobile ) multilingual dictionary for mobile de\
fh: Dro rirdeac / g £s . i 15
] glagl 8

« ABBYY Tutor I

easlly al d effectively mi
« ABBYY Business Card Reader autol
contact inforn 100N Trom a DUSINeSs:

acddress DOOk

ABBYY OCR i(mlh't for mobile software developers
ATV



Extend functionality of mobile devices

with ABBYY technology!

ABBYY, a leading provider of text recognition, dat
and linguistic software, has implemented its techno

into a new generation of applications and tools
for mobile devices:

ABBYY mobile text recognition and translation
applications
ABBYY maobile solutions allow users to turn their device:

|
ak I )
i L) 1 I

scanner, smart translation assistant, or efficient contact management tool

* ABBYY FotoTranslate provides the easiest and fastest way to
translate words by simply taking an image of text with a built-in
camera on mobile devices.

* ABBYY Lingvo Mobile is a multilingual dictionary for mobile devices
that provides accurate translation of words and word combinations .
any time and place.

» ABBYY Tutor is a vocabulary building application which allows users
easily and effectively memorize foreign words.

* ABBYY Business Card Reader automatically captures and stores
contact information from a business card into the mobile phone’s
address book.

3BYY OCR toolkit for mobile software developers

e T La L AR e TR o
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Comprehensive PDF Conversion and PDF Ci

One-click Processing

Open ANY T-,rpe m PDF File

PDFs, POFs with text in curves an

POF file lnto an editable format wi

Create PDF Files Directly Imm Mmrusn!t Giiu:e ;\pph sations

POF Transformer 2.8 Pro is fully inegrated

document, Fxael® table, PowerPalnt® pr

attdahmeant without ladnching POF T

Turn Scanned PDFs to Searchable PDFs

POF Transtarmear 2,0 Prods the anly POF conve

aenorated from a scanneror multi-function peripharal (MFF

Create Secured PDF Files
POF Transformer 2.0 Pro supports the latest
pertain pperalions; sueh as printing, extracting content, editing 2nd ad

P

Save Internal Links and Hyperlinks in Dulput Dﬂcuments
Wihen converting-and creating a POF fite, PDF Translorm fa |
from the original document-and reconstructs them into &

moutput hie

User-friendly Interface
POF Transtormear 2.0 Pro leatures 2 new view-style interface
document and/or saloct desirad pages or areas priot ta startirig t

1t give

touls that allow users:to manually salect the conversion @reas and black types in PDFs

ABBYY'




B emoegaed into other applCallons. txalMples O dppiE
Mobhile OCR Engine include:

he

Capture Front-ends Linked to Backend
Systems and Web Applications

Exisiting applications can be improved Or
extended using OCR for easy capture of input
of data to a networked backend system or
Web applicaition. For example:

- Mobile capture for CRM - take a picture of

a business card for input into a CRM
system or sales lead database

Mobile capture for Workflow - take a
picture of a document for fast input into a
workflow application

- Client/server text conversion and

processing - collecting pieces of texts and
other data via mobile phone camera and
sending 1o a Web or other server for
processing. Mobile OCR can be used for
pre-recognition and to check image
quality, before sending to a server for
processing.
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~ ABBYY

ma ABBYY Mobile OCR Engine 3.0

Compact Code OCR for Mobile Devices

What is the ABBYY Mobile OCR Engine SDK?

The ABBYY Mobile OCR Engine 3.0 Software Development Kit (SDK) is a specialised toolkit
for empowering mobile and other "compact® applications with text recognition and
conversion capabilities. ABBYY's specially developed “compact code OCR" is optimised to
deliver a highly accurate conversion of image files into text using a small amount of

memory and system resources. Fiatform independence ensures support for such operating

systems as Android. Linux, Symbian, Windows and Windows Mobile.

Your Mobile Application with the Power of OCR
ABBYY OCR technology transforms images into manageable text which can be saved, stored, edited
or sent via web, web services, email or SMS. Applications based on the Mobile OCR Engine 3.0 will

transform notes, business cards, newspaper clippings, menus and other texts captured via a mabile
imaging device into data which can easily be embedded into other applications. Examples of appli-

cations which can be enhanced with ABBYY Mobile OCR Engine include:

Capture Front-ends Linked to Backend

Camera Smartphone/PDA Applications:

Take full advantage of cameras on mobile Systems and Web Applications

devices. Photo menus, signs and posters, Exisiting applications can be improved or
business cards, and other documents can be extended using OCR for easy capture of input
converted into text for easier input into a of data to a networked backend system or
variety of applications such as: Web applicaition. For example:

* Phene and address books . Mobile capture for CRM - take a picture of
« Calendars a business card for input into a CRM

system or sales lead database

Mobile capture for Workflow - take a

« Task lists
+ All-in-one personal information o ; 15
managers (PIMs) picture of a document for fast input into a
workflow application

Business card readers i
- Client/server text conversion and

Benefits of the :
ABBYY OCR Engine SDK

- Easy integration of high
performance text recognition
capabilities

- Business card recognition

- Platform independence -
supporting such systems as
Windows Mobile, Symbian,
Android™ and Linux Systems

+ Optimised memory
management and efficient

loading for high performance
- Multilingual support

. Sample application and
test shell

- Sophisticated OCR
functionality:
- Extremely accurate text
conversion
- Multi-column document




